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indipendente, dedicata alla
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La serie su LibreOffice continua...

Continuiamo la nostra raccolta sulla serie LibreOffice di Elmer
Perry con il Volume 4.

Questa è una ristampa diretta della serie 'LibreOffice' parti
27-36, pubblicata nei numeri dal 74 al 83, abbracciando lungo il
percorso Draw, Template, Impress e molte altre caratteristiche
avanzate.

Vi chiediamo, però, di badare alla data di pubblicazione: le
versioni attuali di hardware e software potrebbero essere
diverse rispetto ad allora.
Controllate il vostro hardware e il vostro software prima di
provare quanto descritto nelle guide di queste edizioni speciali.
Potreste avere versioni più recenti del software installato o
disponibile nei repository delle vostre distribuzioni.

Buon divertimento!

Gli articoli contenuti in questa rivista sono stati rilasciati sotto la licenza Creative Commons Attribuzione - Non commerciale - Condividi allo stesso modo 3.0.
Ciò significa che potete adattare, copiare, distribuire e inviare gli articoli ma solo sotto le seguenti condizioni: dovete attribuire il lavoro all'autore originale in
una qualche forma (almeno un nome, un'email o un indirizzo Internet) e a questa rivista col suo nome ("Full Circle Magazine") e con suo indirizzo Internet
www.fullcirclemagazine.org (ma non attribuire il/gli articolo/i in alcun modo che lasci intendere che gli autori e la rivista abbiano esplicitamente autorizzato voi

o l'uso che fate dell'opera). Se alterate, trasformate o create un'opera su questo lavoro dovete distribuire il lavoro risultante con la stessa licenza o una simile o compatibile.
Full Circle magazine è completamente indipendente da Canonical, lo sponsor dei progetti di Ubuntu, e i punti di vista e le opinioni espresse nella rivista non sono in alcun modo da

attribuire o approvati dalla Canonical.
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I l componente LibreOffice Draw è
una applicazione di grafica

vettoriale inclusa nella suite di
LibreOffice. Draw vi permette di
creare grafiche che potranno essere
usate nei vostri documenti.
Nonostante ci siano programmi più
avanzati di grafica vettoriale, come ad
esempio Inkscape, Draw fornisce più
strumenti rispetto ai pacchetti di
disegno inclusi nelle altre suite office.

La grafica vettoriale crea immagini
definendo forme geometriche come
cerchi, rettangoli e poligoni, piuttosto
che con punti pixel sullo schermo.
Grazie a questo le grafiche vettoriali
possono essere riscalate senza
distorsione.

Come gli altri moduli in
LibreOffice, Draw è integrato bene
con gli altri, esso è una scelta quando
si sta creando grafiche per
documenti.

IL LAYOUT PREDEFINITO

Il layout predefinito per Draw è
piuttosto scarno. Probabilmente si
vorrà modificarlo per includere lai
toolbar che si usano maggiormente. Il

layout include gli elementi base di cui
si ha bisogno per creare una
immagine grafica. Il centro dello
schermo è l'area in cui si crea
l'immagine. a destra c'è il pannello
della pagina che mostra le diverse
pagine della grafica. Le grafiche
multipagina sono usate soprattutto
per le presentazioni e ne parlerò più
avanti.

Ci sono tre toolbar predefinite. La
toolbar standard è quella più in alto.
Questa è la toolbar che si vede nella
maggior parte dei componenti di
LibreOffice. Essa controlla le funzioni
'new', 'open', 'save', 'copy', 'cut',
'paste' ecc. che riguardano quasi tutti

i componenti. La toolbar 'line and
filling' sta appena sotto questa.
Questa toolbar controlla come
appariranno le linee e gli oggetti
inseriti. In basso alla finestra c'è la
toolbar 'drawing'. Da questa toolbar è
possibile creare la maggiorparte degli
oggetti per la grafica. La toolbar può
essere spostata prendendola dalla
maniglia all'inizio della toolbar e
trascinarla nel posto in cui la si vuole.

La barra di stato alla base della
finestra fornisce molte informazioni
utili riguardo l'oggetto che si sta
modificando. Il tipo di oggetto, le
dimensioni e l'angolo e altre
informaioznoi utili saranno mostrate

qui. Farò spesso riferimento alla barra
di stato negli How-to (come fare
n.d.t.) su Draw.

Nel bordo alto e a sinistro sono
presenti due righelli. I righelli indicano
in che punto dell'immagine si è. Se si
vuole cambiare l'unità di misura dei
righelli è possibile fare clic con il tasto
destro del mouse sul righello e
selezionare un'unità di misura
differente. Quando si è selezionato
un oggetto i righelli mostrano due
linee per indicare la posizione nel
disegno.

LA BARRA DEL COLORE

La barra del colore mostra il colore
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che si sta utilizzando nella area di
disegno. È possibile usarla per
selezionare i colori per i vostri oggetti
piuttosto che dalla lista a cascata
nella toolbar 'line and filling'. Il primo
box - il box bianco con una croce
all'interno - è il selettore per nessun
colore (o invisibile). Per mostrare la
barra del colore andare su 'View' >
'Toolbar' > 'Color Bar'. Per usarla
barra del colore fare clic con il tasto
sinistro del mouse sul colore con il
quale si vuole riempire l'oggetto e
fare clic con il tasto destrao per
selezionare il colore della linea.

TOOLBAR SGANCIABILI

Molte delle icone hanno un
triangolo o una freccia sulla destra.
Questo indica che l'elemento è

espandibile. facendo clic con il mouse
sulla freccia si ottengono più scelte. È
possibile separare questi elementi
dalla toolbar, crando una toolbar
mobile. Quando espandete
l'elemento si vede alla base un barra
per afferrarlo. Facendo clic con il
mouse su questa barra e
trascinandola si crea una toolbar
mobile con gli elementi. Ciò è molto
utile quando si usano spesso gli stessi
elementi perchè è più veloce che
espandere ogni volta gli elementi.
Quando avete finito basta chiudere la
toolbar mobile facendo clic nel
bottone di chiusura sulla barra del
titolo.

GRIGLIA, LINEE DI

ANCORAGGIO E PUNTI DI

ANCORAGGIO

Quando sto per creare una
immagine, trovo utile avere delle
guide lungo cui lavorare. La griglia, le
linee di ancoraggio e i punti di
ancoraggio sono utili come guide. È
possibile impostare il programma in
modo agganciarsi a queste guide, le
quali aiutano a posizionare in maniera
precisa gli oggetti nel disegno.

Per impostare la griglia andate in
Tools > Options > LibreOffice Draw >
Grid. Se si vuole che gli oggetti si
ancori alla griglia come impostazione
predefinita, spuntare la casella Snap-
to-grid sotto la griglia. Si ha anche la
possibilità di far diventare predefinita

l'opzione di rendere la griglia visibile.
Resolution imposta i parametri
orizzontali e verticali della griglia.
Subdivision imposta il numero di
segnalini tra i punti orizzontali e
verticali della griglia. Maggiore è il
numero di suddivisioni e maggiore
sarà la precisazione con cui ci si
aggancia se l'opzione snap-to-grid è
attiva. In ogni caso, nella maggior
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parte delle situazioni si lavora meglio
con un un giusto mezzo piuttosto
che troppo alto. Dalla sezione Snap è
possibile impostare certe opzioni
come predefinite, ma raccomando di
lasciare queste tutte disattivate ed
usare la toolbar delle opzioni quando
si ha necessità di attivarne alcune. Si
usi il range di ancoraggio per
controllare la distanza entro cui
l'oggetto si aggancia ad un punto.

Diversamente dalla griglia, i punti
e le linee di ancoraggio vengono
inserite quando si ha la necessità di
una maggiore precisione nel
posizionamento. Le linee di
ancoraggio sono ottime per allineare,
orizzontalmente o verticalmente,
oggetti. Per creare una linea o un
punto di ancoraggio Insert > insert
Snap Point/Line dalla barra del menù.
La posizione X controlla la distanza
dal bordo destro dell'imagine. La
posizione Y controlla la distanza dal
bordo alto. Il tipo controlla se si sta
inserendo una punto, una linea
orizzontale o una linea verticale. È
anche possibile creare una linea di

ancoraggio facendo clic e trascinando
sia dal righello orizzontale o verticale.
Per eliminare una linea fare clic e
trascinarla sul righello. Per eliminare
un punto invece, farci clic sopra con il
tasto destro e selezionare Delete
Snap Point.

TOOLBAR DELLE OPZIONI

La toolbar delle opzioni contiene
tutte le opzioni di ancoraggio. Se non
è già aperta si può andare su View >
Toolbar > Options. Dalla toolbar è
possibile scegliere se mostrare o
nascondere le guide, scegliere se
attivare o meno le opzioni di
ancoraggio. Può essere utile
posizionare questa toolbar in basso o
su un lato visto che probabilmente
verranno usate molto spesso le sue
funzionalità.

C'è una ulteriore guida sulla
toolbar che non abbiamo ancora
discusso: Sono le helplines. Quando
voi selezionate le helplines sulla
toolbar delle opzioni, quindi, quando

voi muovete un oggetto, linee
tratteggiate appaiono dagli angoli dei
vostri ogetti ai righelli. Le helplines
sono un ulteriore strumento per
aiutarvi a posizonare accuratamente i
vostri oggetti.

CONCLUSIONE

LibreOffice Draw è lapplicaionze
grafica della suite LibreOffice.Draw
salva la grafica in formato vettoriale
pe rusarlo nei vostri docuemnti creati
con altre applicaiozni della suite.
Draw vi fornisce gli strumenti per
combinare testo e oggetti geometrici
per greare la vostra grafica. Guide e la
abilità di collagarsi automaticamente
alle guide vi aiuta a collocare
precisamente i vostri oggetti.

Nel prossimo How-To vedemo
come ceare degli oggetti grafici di
base in Draw.

Il Podcast Ubuntu copre tutte le
ultime notizie e novità che si
presentano agli utenti di Ubuntu
Linux e ai fan del software libero in
generale. La rassegna è rivolta tanto
all'utente più fresco quanto al
programmatore più esperto. Le
nostre discussioni riguardano lo
sviluppo di Ubuntu ma non sono
eccessivamente tecniche. Siamo
abbastanza fortunati da avere
qualche gradito ospite nello show a
passarci novità di prima mano sugli
ultimi eccitanti sviluppi a cui stanno
lavorando, in modo comprensibile a
tutti! Parliamo inoltre della comunità
Ubuntu e di cosa le interessa.

Lo showè offerto dai membri della
comunità Ubuntu Linux del Regno
Unito. Ed essendo coperta dal
Codice di condotta di Ubuntu è
adatta a tutti.

Lo showè trasmesso live ogni due
settimane il martedì sera (ora
inglese) ed è disponibile per il
download il giorno seguente.

podcast.ubuntu-uk.org

http://podcast.ubuntu-uk.org/
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Quandoerounbambino,midivertivo

agiocareconlecostruzioni.Non

avevoiblocchifinementerifinitie lucenti

chesipossonocomprareoggigiornoperi

bambini.Avevoinvecepezzidi legnoda

miopadrefalegname.Hofinitocon

l'avereunaraccoltadivarieformee

dimensionigeometriche.Questiblocchi

divennerofortiniper imieisoldatini,

stradeperleautomobilieperfinoun

paesaggiourbanocompletodi

aeroporto.L'unicolimiteeralamia

immaginazione.

Sebbenelemiecapacitàartistiche

nonsonoavanzatemoltooltreilnono

gradodi lezionid'arte,midivertoancoraa

mettereinsiemelecoseehosempre

apprezzatolageometria. Imieiblocchimi

hannoinsegnatochelamaggiorparte

dellecosepossonocollassareinforme

geometrichedibasecomecerchi,

rettangoliealtreformegeometriche2D.

Conquestioggettièpossibilecreare,

anchesesoloinformarudimentale,

qualsiasicosa.

AlcentrodiLibreOfficeDrawcisono

questeformegeometrichedibase.Esse

consentonodidisegnarequalsiasicosae

l'unicolimiteèlavostra immaginazione.

Troveretetuttiglioggettidibasesulla

barradeglistrumenti 'Disegno'.Partendo

dalpiùsemplicedituttiglielementidi

disegno, la linea,diamounosguardoa

comeusareglioggettidibasedisponibili

inLibreOfficeDraw.

LINEEEFRECCE

Lalineaèilsecondostrumentosulla

barradeglistrumentipredefinita

'Disegno',essendo ilprimolostrumento

'Seleziona'.Perdisegnareunalinea,fate

clicnell'areadidisegnoincuivolete

iniziarela lineaetrascinatelafinoalpunto

incuivoleteterminare.Sedateuno

sguardoallabarradistatomentre

disegnatelalinea,noteretecheindicala

dimensioneel'angolazionedella linea.

Perlimitarel'angolodella lineacon

intervallidi45gradi (0,45,90,135,180,

-135, -90, -45),tenetepremutoiltasto

Shiftmentreladisegnate.

Talvolta,sidevedisegnarelalineada

unpuntocentraleanzichédaunadelle

estremità.TenetepremutoiltastoAlt

mentredisegnatelalineaequesta

cresceràalleestremitàdelpunto

centrale.Potetetenerepremuti insieme

Alt+Shiftperdisegnareunalineadal

puntocentraleelimitarel'angolocon

incrementidi45gradi.

Sullabarradeglistrumenti 'Disegno'

c'èanchelabarradeglistrumentiestesa

'Lineeefrecce'.Vipermettedidisegnare

lineecondifferentifrecceepuntidi

partenza.C'èancheunalineaper

visualizzareledimensioni.Perdisegnare

lelineeconlefrecce,poteteusaretuttigli

stessimetodiutilizzatiper lefrecce

ordinarie.

Utilizzatelabarradeglistrumenti

'Stileeriempimento'permodificarelo

stiledella linea, lospessoreeper

colorarla.Assicuratevichelalineasia

selezionataquandofatequeste

modifiche.Poteteinoltreselezionare

differentistilidifrecceperlevostrelinee

usandolostrumento'Stileestremità

linea'sullabarradeglistrumenti 'Stilee

riempimento'.

RETTANGOLIEQUADRATI

Sevolevate,potevateutilizzarela

funzione'Catturaallagriglia'e il tasto

Shiftperdisegnarequattrolineeper

creareunrettangoloounquadrato,ma

Drawfornisceunmodopiùsempliceper

crearli. Il rettangoloèilquartostrumento

sullabarradeglistrumentipredefinita

'Disegno'.Conessopotetecreare

rettangoliequadrati.

Perdisegnareunrettangolo,

selezionatelostrumento'Rettangolo'

dallabarradeglistrumenti.Fateclicdove

voleteposizionareunodegliangolie

trascinatefinoalpuntodicollocamento

dell'angoloopposto.Otteneteun

quadratotenendopremutoiltastoShift

mentredisegnate. Il tastoShiftassicura

chel'altezzaelalarghezzasianouguali.
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Propriocomeconlelinee,talvolta

bisogneràcreareunrettangolooun

quadratoapartiredalpuntocentrale

anzichédall'angolo.Dinuovo, il tastoAlt

faràsicheil rettangolosiespandadal

centro.UsarelacombinazioneShift+Alt

perdisegnareunquadratodalpunto

centrale.

I rettangolie iquadratisonodisegnati

inmanierapredefinitaconlalineaeil

colorediriempimentoselezionateal

momento.Potetecambiareciòusandola

barradeglistrumenti 'Stilee

riempimento'.Poteteancheusarela

'Barradeicolori':clicconiltastodestro

per ilcoloredella lineaeconiltasto

sinistroper ilcolorediriempimento.

Poteteanchecontrollarelospessoreelo

stiledella lineadelbordousandolabarra

deglistrumenti 'Stileeriempimento'.

ELLISSI ECERCHI

Lostrumento'Ellisse'è ilquintosulla

barradeglistrumentipredefinita

'Disegno'.Leellissivengonodisegnate

quasiallastessamanieradeirettangolie

deiquadrati.Fondamentalmente,state

disegnandounrettangolocheconterràla

vostraellissiocerchio.Propriocomeperi

quadrati, il tastoShiftvipermetteràdi

disegnareuncerchio, il tastoAltèusato

perdisegnarelavostraellisseapartiredal

puntocentraleelacombinazione

Shift+Altvipermetteràdidisegnareun

cerchiodalpuntocentrale.

Comeperirettangolie iquadrati, le

ellissie icerchisonodisegnaticonlalinea

eilcolorediriempimentoselezionatial

momento.Potetecambiarli tramitela

barradeglistrumenti 'Stilee

riempimento'oconla 'Barradeicolori'.La

primavipermetteanchedicambiarelo

stiledella lineadelbordoelospessore.

BARREDEGLISTRUMENTIESTESE

PERFORMEESIMBOLI

Oltreallabarradeglistrumentiestesa

'Lineeefrecce',avetediversealtrebarre

deglistrumentiestesetracuiscegliere,

cheincludono: 'Formebase' (oggetti

geometrici in2D), 'Formesimboli' (faccine

sorridenti, luna,cuore,ecc.), 'Frecce

blocchi', 'Diagrammidiflusso', 'Legende'

e 'Stelle'.Questebarredeglistrumenti

estesevifornisconoun'ampiagammadi

oggettipercostruire ivostrigrafici.

Vengonodisegnatipiùomenoallo

stessomododeirettangoli,quadrati,

ellissiecerchi.Disegnateunrettangolo

contenitivoperl'oggetto.Ancheitasti

ShifteAlt lavoranosumoltioggettialla

stessamanieracheconirettangoli.

Poteteusarelabarradeglistrumenti

'Stileeriempimento'percambiarelo

spessoredella linea, ilcoloredella lineae

ilcolorediriempimentodell'oggetto.

ESEMPIODIDISEGNO -UNRAZZO

SEMPLICE

Comehodettoall'inizio,nonho

moltodell'artista,mahouncertosenso

nelmettereinsiemeleformepercreare

unoggetto,quindi incamminiamoci

attraversolacreazionediun'immagine

moltosemplicediunrazzo.Lungoil

percorsointrodurròalcuninuovi

strumentieconcettiper lavorarecon

semplici figure.

Inizialmente, imposteremounagriglia

per ilnostrodisegno:Strumenti>Opzioni

>LibreOfficeDraw>Griglia. Impostiamo

lerisoluzioneverticaleeorizzontalea1

inch(2,54cm)edentrambi lesuddivisioni

a10.Ciòcreeràunbelreticolatodella

grigliadaunpollicesullanostrasuperficie

dadisegno.Controllarel'opzione'Cattura

allagriglia'.Questociaiuteràadaverei

nostrioggettidellagiustadimensione.

Iniziamoconl'ogiva.Selezionatelo

strumento'Triangoloisoscele'dallabarra

deglistrumentiestesa'Formebase'.
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Disegnateiltriangolo,di2x2reticolati,

nellapartealtadell'immagine.Rendetele

lineedicoloreneroeil riempimentodi

grigio30%.Per ilcorpodelrazzo,usate

unrettangolodi2reticolatidi larghezza

per6reticolatidialtezza,coloredella

lineaneroecolorediriempimentogrigio

30%.

Aggiungiamoalcunealette

stabilizzatricialnostrorazzo.Selezionate

iltriangolorettangolodallabarradegli

strumentiestesa'Formebase'e

disegnateloinbassoadestradelcorpo

delrazzo,2reticolatidialtezzaperunodi

larghezza. Impostateilcoloredella lineaa

neroeilcolorediriempimentoagrigio

40%.Conl'alettaappenacreata

selezionata,andiamoinModifica>Copia,

poiModifica>Incolla.Lacopiaapparirà

sopralapartesuperioredellaprima

aletta.Trascinatelacopiaerilasciatela

nellapartesinistradelcorpodelrazzo.

Fateclicconiltastodestrosullacopiae

poisuRibalta>Orizzontale.Spostatela in

bassoadestradelcorpodelrazzo.Conla

copiaancoraselezionata,premetetre

volteil tastofreccia ingiùperspostarla

appenasottoalcorpodelrazzo.Fatelo

stessoconl'alettadestra.

Completeremoilnostrodisegnocon

loscaricodelmotore.Createuntriangolo

isoscelenellapartebassacentraledel

corpodelrazzo.Usateilvostromiglior

giudizioperladimensione. Ilpuntoinalto

deltriangolodevesovrapporsiconla

partebassadelcorpodelrazzo.Rendete

ilcoloredella lineaneroequellodi

riempimentogrigio60%.Assicurateviche

loscaricosiacentratonellapartebassa

delcorpo.Fateclicconiltastodestrosul

triangoloepoisuDisponi>Portain

fondo.Ciòspingeràiltriangolodietrogli

altrioggetticosìpossiamovederesolola

partepiùbassa.Ecco!Aveteundisegno

veramentesemplice.

CONCLUSIONI

Leformebasesonoimattonciniper

le immagini inDraw.Daloro,potete

crearedisegnitantosempliciocomplicati

quantoservealvostrodocumento.

Potetesistemareglioggetti

sull'immaginepersovrapporsigliunicon

glialtrieribaltarlipercambiare

l'orientamentoverticaleoorizzontale.

NelprossimoHow-Tovimostrerò

comecrearearchi,curveepoligoninelle

vostreimmagini.

UBUNTU TOUCH SDK BETA

S tiamo [Canonical] annunciando oggi la beta di Ubuntu SDK.

L'SDK fornisce un insieme di API che includono gli strumenti per

la UI (interfaccia utente - N.d.T.), rendendo gli sviluppatori capaci di

creare applicazioni reattive e interattive con una UI nativa di Ubuntu

mobile. Qt Creator è un IDE con una interfaccia visuale per scrivere,

collaudare e sviluppare applicazioni; la documentazione delle API e

un sito per gli sviluppatori pieno di risorse e tutorial lo rendono

facile per la creazione di applicazioni di qualità.

Insieme a una comunità di sviluppatori di applicazioni vibrante e

in continua crescita, Ubuntu e l'SDK forniscono il miglior ecosistema

per far prosperare le vostre applicazioni.

PER INIZIARE - GUIDA ALL'INSTALLAZIONE DEL SDK

Per iniziare con Ubuntu SDK, incluse le istruzioni per la facile

installazione, i tutorial e la dettagliata documentazione delle API,

visitate il sito developer.ubuntu.com/get-started

Per aiutarvi a progettare e costruire bellissime applicazioni, la

Guida alla Progettazione delle Applicazioni include ogni cosa

necessaria per conoscere UX e le migliori pratiche per la

progettazione visuale. La trovate presso design.ubuntu.com/apps

Potete mantenere aggiornato il vostro telefono di sviluppo con

l'ultima build seguendo le istruzioni presso

wiki.ubuntu.com/TouchInstallProcess

ANNUNCIO DALLA CANONICAL

http://developer.ubuntu.com/get-started
http://design.ubuntu.com/apps
http://wiki.ubuntu.com/TouchInstallProcess
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C ome ho detto l'ultima volta, le
costruzioni che avevo da

bambino erano il risultato del lavoro
di falegnameria di mio padre. Non
tutti i blocchi erano perfettamente
proporzionati in nitide forme
geometriche. Talvolta erano
sagomati in modo strano, o, come
accade spesso con il legno, modellati
spaccandosi lungo la venatura invece
di essere tagliati dalla sega. Alcuni
avevano disegni curvi là dove le loro
parti mancanti erano state utilizzate
per aggiustare una sedia o un mobile.
Non scartavo queste forme irregolari
ma me le tenevo. Non tutte le cose
nel nostro mondo sono state create
da linee rette, ellissi e cerchi.

Tenendo a mente ciò,
continuiamo a dare uno sguardo a
LibreOffice imparando come creare
poligoni, archi e curve. Un poligono è
un oggetto piano con almeno tre
linee rette e angoli. In termini
geometrici, i quadrati, i rettangoli e i
triangoli sono tipi di poligoni. Per i
nostri scopi, discuteremo dei poligoni
con più di quattro lati. Un arco, in
Draw, è un parziale cerchio o ovale.
Possiamo farlo pieno o vuoto. Una
curva è una linea inarcata. Vedremo

due metodi per creare le curve, lo
strumento 'Curva' e il metodo Bezier.

DISEGNARE POLIGONI

Come ho detto, un poligono è un
oggetto con molteplici lati. In Draw si
possono avere quattro strumenti
Poligoni. Due per i poligoni chiusi e
pieni e due per i poligoni aperti e
vuoti. Gli strumenti per i poligoni
vuoti sono ottimi per realizzare una
serie di linee. Per entrambi i tipi, c'è
una versione a forma libera e una
limitata ad angoli che sono multipli di
45 gradi.

Per creare un poligono,
selezionate uno degli strumenti
poligono dalla barra degli strumenti
estesa 'Curva'. Fate clic e trascinate
per creare il punto di partenza della
prima linea. Quando rilasciate il

pulsante del mouse, viene creato il
punto in cui finisce la prima linea.
Spostate il mouse dove volete che
termini la seconda linea e fate clic.
Continuate fino a che non avrete
creato tutte le linee del poligono.
Fate doppio clic sull'ultimo punto per
terminare il poligono.

Se state usando uno degli
strumenti 'Poligono pieno', Draw
riempie il poligono con il colore di
riempimento attualmente
selezionato e imposta le linee con il
colore attualmente selezionato.
Potete cambiarli usando la barra degli
strumenti 'Stile e riempimento'.

AGGIUNGERE LA BARRA DEGLI

STRUMENTI 'CERCHI ED ELLISSI'

Per un accesso veloce allo

strumento per cerchi ed ellissi, è
necessario aggiungere la barra degli
strumenti avanzata 'Cerchi ed ellissi' a
quella 'Disegno'. Fate clic con il tasto
destro sulla barra dei strumenti
'Disegno' e selezionate 'Personalizza
barra degli strumenti'. Si aprirà la
finestra di dialogo 'Personalizza' nella
quale dovrete selezionare 'Importa..'.
Selezionate quindi 'Disegno' dalla
lista delle categorie. Nella lista dei
comandi, trovate lo strumento
'Ellisse', ce ne sono due. Vogliamo
usare quello la cui descrizione è
'Utilizzando Personalizza barre degli
strumenti potete aggiungere l'icona
ellisse, che apre la barra degli
strumenti Circonferenze e ovali'.
Premete il pulsante Aggiungi e poi
quello Chiudi.

Usando i tasti freccia su e giù,
spostate la nuova icona dove volete
nella barra degli strumenti. Io ho
sistemato la mia sotto allo strumento
'Ellisse'. In realtà quest'ultimo
strumento non è più necessario
poiché è incluso in 'Cerchi ed ellissi',
quindi deselezionatelo. Premete sul
pulsante OK e dovreste vedere che la
barra degli strumenti avanzata 'Cerchi
ed ellissi' è ora in quella 'Disegno'.
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DISEGNARE ARCHI O SEGMENTI

Per disegnare
un arco o un
segmento,
selezionate uno
degli strumenti
dalla barra 'Cerchi

ed ellissi' appena aggiunta. Fate clic e
trascinate per creare un contenitore
circolare od ovale. Rilasciate poi il
pulsante del mouse. Fate clic nel
cerchio o nell'ovale dove volete che
inizi l'arco o il segmento. Spostate il
mouse intorno al disegno per creare
l'arco o il segmento. Fate clic una

seconda volta per creare il punto
finale. La barra di stato mostrerà
l'angolazione dal centro del punto
mentre vi muovete intorno al cerchio
o all'ovale. Questo può aiutarvi a
creare archi e segmenti accurati e
precisi.

DISEGNARE CURVE

Una curva è una linea piegata
piuttosto che un segmento di un
cerchio o ovale. Per disegnare una
curva, selezionate lo strumento
'Curva', fate clic sul punto di partenza
e rilasciate per disegnare una linea.
Rilasciate il pulsante del mouse nel
punto di picco della curva. Spostate il
mouse per piegare la linea fino al
punto in cui si desidera che la curva
finisca. Fate doppio clic per
completare la curva.

CURVE BEZIER

Una curva Bezier è una curva liscia
con un punto iniziale, un punto finale

e due punti di controllo. La
matematica dietro alla curva di Bezier
va oltre gli scopi di questo articolo,
ma non vi serve di capirla al fine di
disegnarne una.

Per disegnare una curva di Bezier,
selezionate lo strumento 'curva' dalla
barra degli strumenti. Fate clic nel
punto iniziale, trascinate fino al punto
finale e fate doppio clic. Fate poi clic
sullo strumento 'Punti' nella barra
degli strumenti 'Disegno' (F8 sulla
tastiera) e apparirà la barra degli
strumenti 'Modifica punti'.
Selezionate sia il punto iniziale che
quello finale (quello iniziale ha il
quadrato più grande). Selezionate lo
strumento 'Smorzamento lieve' o
'Transito simmetrico' dalla barra
'Modifica punti'. Spostate il punto di
controllo per creare la curva per quel
punto. Ripetete questi passi per
l'altro punto.

CONCLUSIONI

Poiché non tutte le cose sono
create da linee dritte, ellissi e cerchi, i

creatori di Draw ci hanno fornito
molti strumenti per creare oggetti.
Un poligono può creare un oggetto
con più di quattro lati. Archi e
segmenti vi danno parti e segmenti di
un cerchio o di un'ellisse. Le curve
danno la possibilità di piegare una
linea in forme diverse. Con questi
strumenti supplementari in mano,
Draw vi consente di creare immagini
più avanzate per i vostri documenti.

La storia lavorativa, di programmazione
e informatica di Elmer Perry include un
Apple IIE, con alcuni Amiga, un generoso
aiuto di DOS e Windows e una
spolverata di Unix, il tutto ben
mescolato con Linux e Ubuntu.
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Q uando lavoriamo con i blocchi fisici,
a volte è necessario cambiarne la

forma, personalizzarli per scopi speciali.
Possiamo usare una pialla o una
levigatrice per fare un taglio laterale o
per arrotondare uno spigolo. Potremmo
usare una sega per segare un angolo. Il
tutto per creare uno speciale blocco
personalizzato differente da qualsiasi
altro blocco della nostra collezione.

Avolte, occorre fare la stessa cosa
con i blocchi digitali. Gli strumenti di
modifica forniti con LibreOffice Draw
diventano la nostra pialla, levigatrice e
sega digitale. Difatti, possiamo fare cose
che non ci saremomai sognati di fare ai
blocchi quando eravamo bambini.

FINESTRA LINEA

La finestra di dialogo 'Linea' ci
permette di editare l'aspetto delle linee
nei nostri oggetti. Per accedere alla
finestra di dialogo 'Linea', fare clic con il
tasto destro sul proprio oggetto e
selezionare 'Linea'. Da qui, possiamo
cambiare lo stile della linea (piena,
tratteggiata, a puntini, ecc.), il colore,
l'ampiezza e la trasparenza. Possiamo
inoltre aggiungere stili freccia alle
estremità della linea. Tenete in mente

che per racchiudere oggetti (triangoli,
quadrati, cerchi, ecc.), le frecce non sono
disegnate sulle linee. Al di sotto degli
stili freccia, possiamo regolare
l'ampiezza della freccia. 'Centro' colloca
il centro della punta della freccia nel
punto finale della linea selezionata.
'Sincronizza estremità' aggiorna
automaticamente entrambe le frecce
quando cambiamo lo stile, l'ampiezza o il
centro di una delle estremità. 'Stile
angolo' controlla come viene disegnato
l'angolo del nostro oggetto. 'Stile
estremità' controlla come appariranno le
estremità delle linee senza le frecce.

Se stiamo lavorando con un oggetto

aperto, otteniamo una scheda 'Ombre'.
Questa ci permette di creare un'ombra
per la linea definendone la posizione, la
distanza, il colore e la trasparenza.

Le schede 'Stili linee' ed 'Estremità
linee' ci permettono di aggiungere,
modificare, cancellare e salvare
differenti stili di linee e frecce. Potete
giocarci un po', ma generalmente potete
trovare ciò che vi occorre negli stili
predefiniti. In caso contrario, sentitevi
liberi di creare il vostro.

FINESTRA AREA

La finestra di dialogo 'Area' si usa con

gli oggetti chiusi e si occupa dello spazio
dentro agli oggetti. Possiamo cambiare
il colore di riempimento nonché ilmodo
in cui l'oggetto è riempito. Per accedere
alla finestra di dialogo 'Area', fare clic
con il tasto destro sull'oggetto e
selezionare 'Area'.

La scheda 'Area' controlla ciò che
riempie l'oggetto. Possiamo scegliere
fra colore, sfumatura, tratteggio e
bitmap nella lista a tendina. Una volta
scelto il tipo di riempimento, possiamo
selezionare un riempimento dall'elenco.
La casella di anteprima mostra il risultato
della selezione.

La scheda 'Ombre' ci permette di
aggiungere un'ombra sotto all'oggetto.
Spuntare 'Applica ombra' per crearne
una. Posizione determina l'ubicazione
dell'ombra e Distanza la lontananza
dall'oggetto. Colore determina il colore
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dell'ombra e Trasparenza ne imposta
l'opacità.

Nella scheda 'Trasparenza',
determiniamo l'opacità del riempimento
dell'oggetto. Abbiamo tre opzioni tra cui
scegliere. Nessuna trasparenza significa
che il riempimento è completamente
opaco. In Trasparenza possiamo
impostare una percentuale per l'intera
area. Sfumatura è l'opzione con le
maggiori impostazioni e la possibilità di
creare gli effetti più interessanti.
Abbiamo sei possibili scelte per il tipo di
sfumatura: lineare, assiale, radiale,
elissoidale, quadratico e quadrato. Per
tutte, eccetto lineare e assiale, possiamo
controllare il centro XYdel gradiente. Il
centro XYè il punto in cui l'oggetto è più
chiaro o più trasparente. Eccetto per il
radiale, possiamo anche definire un
angolo per l'area del gradiente.
L'impostazione Bordo riduce la
dimensione dell'area di trasparenza.
Tanto più ampia è la percentuale, tanto
più piccola sarà l'area di trasparenza.
UsiamoValore iniziale e Valore finale

per cambiare il livello di opacità iniziale e
finale. Peresempio, se non vogliamo
una zona totalmente chiara sul nostro
oggetto, possiamo iniziare con un valore
di 1 0 o 1 5%.

Le schede 'Colori', 'Sfumature',
'Tratteggio' e 'Bitmap' ci permettono di
creare nuovi stili di riempimento
definendo nuovi colori, sfumature,
tratteggi e bitmap.

FINESTRA POSIZIONE E

DIMENSIONE

Oltre a controllare la posizione e la
dimensione di un oggetto, la finestra di

dialogo 'Posizione e Dimensione' ci
permette di controllarne la rotazione,
l'inclinazione e il raggio angolare. Per
accedere alla finestra di dialogo
'Posizione e Dimensione', fare clic con il
tasto destro sull'oggetto e selezionare
'Pozione e Dimensione'.

La finestra di dialogo Posizione e
Dimensione fa proprio quello che ci
aspettiamo. Possiamo controllare la
posizione XYsulla tela dell'oggetto e la
sua altezza e larghezza. Il punto base per
ciascuna delle opzioni fornisce nove
punti sull'oggetto dai quali viene
calcolata la posizione o la dimensione.

Sotto a Dimensione, c'è la casella di
spunta Mantieni rapporto che aiuta a
mantenere le proporzioni dell'oggetto
(qualsiasi cambiamento nell'altezza
provocherà un cambiamento nella
larghezza e viceversa). Abbiamo inoltre
le opzioni perproteggere il
posizionamento o la dimensione da
cambiamenti accidentali. L'opzione
Adatta è relativa alle cornici di testo e ci
permette di adattare la larghezza e/o
l'altezza per coincidere con il testo.

Sulla scheda Rotazione, possiamo
controllare la rotazione dell'oggetto.
Questa è generalmentemolto più
accurata dello strumento rotazione.
Possiamo selezionare il punto di perno
attraverso la casella di inserimento o
selezionandolo dalla casella
Impostazioni predefinite. Selezioniamo il
nostro angolo attraverso la casella di
inserimento o scegliendo un punto tra
quelli agli angoli in Impostazioni
predefinite.
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e Ubuntu. I l suo blog si trova presso
http://eeperry.wordpress.com
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Infine, la scheda Raggio
d'inclinazione e rotazione ci permette di
controllare la rotondità degli angoli e
l'inclinazione (pensiamo al corsivo).
Pensiamo al raggio d'inclinazione come
alla carta vetrata per arrotondare un
angolo. Più si smeriglia, più l'angolo si
arrotonda. Più grande è il numero, più
rotondo è l'angolo. Se impostiamo il
raggio dell'angolo abbastanza alto su un
rettangolo, si trasformerà in un ovale.
L'inclinazione, data come angolo, inclina
l'oggetto verso destra perun angolo
positivo e verso sinistra perun angolo
negativo. Usando il raggio d'inclinazione
e rotazione, possiamo ottenere alcune
forme interessanti. Il raggio

d'inclinazione è bloccato per alcuni
oggetti.

DISPONI, ALLINEAMENTO,
RIBALTA, CONVERTI

Avolte diventa quasi necessario
accatastare oggetti, farli allineare,
ribaltarli, o semplicemente convertirli in
qualcosa che è possibile modificare in un
modo diverso. Tutti i comandi seguenti
si trovano facendo clic con il tasto destro
sull'oggetto. Sono inoltre disponibili nel
menù Modifica.

L'opzione 'Disponi' ci permette di
controllare la posizione di
accatastamento degli oggetti. Quando
abbiamo oggetti multipli che si
sovrappongono, potremmo aver
bisogno di cambiare l'ordine col quale

sono impilati. Per impostazione
predefinita, sono accatastati nell'ordine
in cui vengono creati, l'ultimo in cima.
Usando l'opzione 'Disponi', possiamo
spingere gli oggetti in avanti o
all'indietro nella pila finché non
raggiungiamo il risultato voluto.

'Allineamento' ci permette di
allineare gli oggetti rispetto agli altri
oppure alla pagina. Se abbiamo
selezionato solo un oggetto, questo
sarà allineato alla pagina corrente. Se
sono selezionati più di un oggetto,
saranno allineati in base a ogni altro. Il
più largo degli oggetti controlla
generalmente l'ubicazione finale e gli
altri oggetti vengono spostati per
allinearsi alla posizione selezionata di
tale oggetto. Le opzioni di allineamento
sono Asinistra, Centrato, Adestra, In
alto, Al centro e In basso. Drawha una
barra degli strumenti Allineamento in
aggiunta almenù con il tasto destro e a
quelloModifica.

Le opzioni 'Ribalta' sono chiare.
Possiamo ribaltare un oggetto
verticalmente (dall'alto in basso) od
orizzontalmente (da sinistra a destra).

Ci sonomolte opzioni sotto a
'Converti', ma è su una in particolare che
voglio attrarre la vostra attenzione,
Converti > In curva. Con la conversione
di qualsiasi oggetto in una curva,

possiamomodificare i punti all'interno di
tale oggetto, permettendoci di
conseguire forme completamente
originali. Una volta che un oggetto è
curvato, possiamo aggiungerci punti,
rimuoverli e usare lo strumento
'Modifica punti' sui punti dell'oggetto.
Convertite un rettangolo in una curva,
quindi iniziate ad aggiungere, spostare e
manipolare i punti e vedete cosa potete
creare.

CONCLUSIONI

Le opzioni in Drawpermodificare gli
oggetti sono numerose. Applicando il
giusto strumento su un oggetto,
possiamo creare quasi qualsiasi forma
che possiamo immaginare (forse alcune
che non avetemai immaginato). Vi
incoraggio a giocare con questi
strumenti per vedere cosa potete
inventarci. Non si sa mai, potreste
scoprire quel piccolo artista o
progettista che è in voi.

http://eeperry.wordpress.com
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S e lavorate spesso con LibreOffice, vi
ritroverete spesso a usare la stessa

formattazione più e più volte. Sia che lo
usiate per scrivere lettere o per creare il
nuovo best-seller, trascorrete molto
tempo a impostare lo stesso stile di
nuovo più e più volte. I template sono la
risposta a questo problema. Un
template è un modello di documento
usato per creare altri documenti. Tutte
le applicazioni di LibreOffice possono
usare i template. Di fatto, ogni volta che
si crea un nuovo documento,
LibreOffice usa un template predefinito.

Gli Stili sono la chiave per creare i
template. Gli Stili sono un modo
preimpostato di visualizzare
informazioni. Inizialmente, nella parte 3
di questa serie, ho parlato
dell'importanza di usare gli stili lungo
tutto il tragitto, discutendo di come
possono aiutare a creare un aspetto
uniforme nei propri documenti e a
risparmiare tempo. In questo spirito,
possiamo aggiungere un ulteriore uso
degli stili, la creazione di template.

IMPOSTARE UN TEMPLATE

Ogni cosa, da una lettera

commerciale a una ricerca scientifica,
richiede uno specifico aspetto e
formato. Diciamo che stiamo scrivendo
un documento che richiede una
formattazione a struttura numerata con
dei sotto livelli. Un'altra esigenza è che il
titolo e l'autore appaiano in cima a ogni
pagina e il numero della pagina, nel
formato 'Pagina # di #', appaia in basso.

Affronteremo prima lo stile della
numerazione. In un nuovo documento di
Writer, apriamo la finestra 'Stili e
formattazione'. Facciamo clic sull'icona
'Stili di elenchi' (l'ultima sulla barra degli
stili). Selezioniamo 'Numerazione 1 '.
Facciamo clic con il tasto destro e
scegliamo Modifica. Sulla scheda
'Struttura' scegliamo lo stile etichettato
'Numerico con tutti i sottolivelli' (appare
al passaggio del mouse sopra di essi).
Facciamo clic su Applica e poi su OK.

Ora occupiamoci dell'intestazione e
del piè di pagina. Apriamo la finestra
'Stili e formattazione' e facciamo clic
sull'icona 'Stili di pagina' (la penultima
sulla barra degli stili). Facciamo clic con il
tasto destro su 'Stile predefinito' e
selezioniamo Modifica. Sulla scheda
'Riga d'intestazione' spuntiamo 'Attiva
riga d'intestazione', poi passiamo alla

scheda 'Piè di pagina' e spuntiamo
'Attiva piè di pagina'. Premiamo su OK
per salvare i cambiamenti. Facciamo clic
sull'area dell'intestazione della prima
pagina e quindi su Inserisci > Comando
di campo > Titolo. Digitiamo uno spazio
e "by", quindi Inserisci > Comando di
campo > Autore. Spostiamo il cursore in
fondo sul piè di pagina. Digitiamo:
'Pagina', uno spazio, quindi Inserisci >
Comando di campo > Numero di pagina,
spazio, 'di', spazio e infine Inserisci >
Comando di campo > Numero di pagine.

SALVARE IL TEMPLATE

Siamo ora pronti per salvare il nostro
template. File > Salva come modello...
aprirà il 'Gestore dei modelli'.
Selezioniamo la cartella dei template
dove vogliamo archiviare il nostro
modello. Facciamo clic su Salva. Una
finestra di dialogo ci chiederà di dare un
nome al template. Inseriamo il nome che
vogliamo dargli e premiamo OK.
Chiudiamo il Gestore dei modelli.
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USARE IL TEMPLATE

Usiamo il nostro template appena
creato. File > Nuovo > Modelli.
Apriamo la cartella dove abbiamo
salvato il modello e facciamo doppio
clic sul nostro template. Il titolo
mostrato è quello che gli abbiamo
dato. Cambiamolo. File > Proprietà,
selezioniamo la scheda 'Descrizione' e
cambiamo il titolo in qualcos'altro.
Premiamo OK. Il titolo
nell'intestazione cambierà in qualsiasi
cosa abbiamo digitato lì.

Proviamo il sistema di
numerazione. Apriamo la scheda 'Stili
e formattazione', facciamo clic
sull'icona 'Stili di elenchi' e doppio clic
su 'Numerazione 1 '. Il nostro input
cambierà nello stile della lista definito
per 'Numerazione 1 ' durante la
creazione del modello. Aggiungiamo
del testo e assicuriamoci di
aggiungere diversi livelli per
constatare che tutto funzioni. Ora
possiamo salvare il documento come
faremo normalmente. Ciò non lo
salva come template ma come file sul
nostro computer.

IMPOSTIAMO UN NUOVO

TEMPLATE PREDEFINITO

Se ci occorre utilizzare il nostro
nuovo template molto spesso,
perché non renderlo il template
predefinito? È facile con
LibreOffice. File > Nuovo > Modelli ,

navighiamo nella cartella del
template e selezioniamolo.
Facciamo clic sul pulsante 'Imposta
come predefinito'. Ora, ogni volta
che apriamo un nuovo documento
di questo tipo, LibreOffice userà il
nostro template al posto di quello
che viene fornito come predefinito.

Differenti sorgenti per i
template

Creare un proprio template è
magnifico, ma non è sempre
necessario fare tutto questo
lavoro. I l repository ufficiale di
template presso
http://templates.libreoffice.org ha
centinaia di modelli per noi da
provare e usare. Per usarne uno
specifico, importarlo nel Gestore
dei modelli .

Alcuni template sono raccolte.
Hanno una estensione .OXT. Per
importarli , usiamo lo strumento

http://templates.libreoffice.org
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Scrive il suo blog a
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'Gestione estensioni'. Strumenti >
Gestione estensioni, premiamo
'Aggiungi' e navighiamo fino al file OXT
scaricato. Selezioniamolo e facciamo
clic su Apri. Il gestore di estensioni
processerà il file e aggiungerà la
raccolta nel nostro Gestore di modelli.

CONCLUSIONI

I template sono un modo per
ripetere la formattazione di un
documento a tutti gli altri. La creazione
e il salvataggio di un modello si basa
principalmente sull'uso degli stili.
Anche se vi ho dimostrato la creazione
di un template con Writer, li potete
anche creare negli altri moduli di
LibreOffice. Potete perfino impostare
il vostro modello come predefinito per
tipologia di documento. I template
sono solo un altro degli strumenti
salva-tempo della suite LibreOffice.

EDIZIONI SPECIALI DI PYTHON:

http://fullcirclemagazine.org/issue-py01 / http://fullcirclemagazine.org/issue-py02/

http://fullcirclemagazine.org/python-
special-edition-issue-three/

http://fullcirclemagazine.org/python-
special-edition-volume-four/

http://fullcirclemagazine.org/python-
special-edition-volume-five/

http://fullcirclemagazine.org/python-
special-edition-volume-six/

http://eeperry.wordpress.com

http://fullcirclemagazine.org/issue-py01/
http://fullcirclemagazine.org/issue-py02/
http://fullcirclemagazine.org/python-special-edition-issue-three/
http://fullcirclemagazine.org/python-special-edition-volume-four/
http://fullcirclemagazine.org/python-special-edition-volume-five/
http://fullcirclemagazine.org/python-special-edition-volume-six/
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S e avete fatto delle
presentazioni, sapete che

tornare sul computer per far
avanzare le diapositive è una
sofferenza, specialmente se, come
me, ci si sposta molto e si
coinvolgono attivamente gli
auditori. Recentemente ho
presentato un lavoro per una
sessione di formazione e ho
costantemente desiderato di avere
un telecomando. La Document
Fondation ha previsto una soluzione
nell'applicazione Android Impress
Remote. Impress Remote ci
permette di controllare la
presentazione fatto con Impress dal
nostro cellulare o tablet Android.

Impress Remote richiede la
versione 4.0.1 o superiore di
LibreOffice e un cellulare o tablet
su cui gira Android 2.3 o superiore.
Se possedete un cellulare o un
tablet recenti e la vostra
distribuzione Linux è aggiornata,
non dovreste avere nessun
problema nell'usare il programma.

IMPOSTAZIONE

Per avviare il programma
Remote, avrete bisogno di
apportare cambiamenti alle
impostazioni di LibreOffice Impress.
Iniziate aprendo una nuova o già
esistente presentazione. Quindi
Strumenti > Opzioni > LibreOffice >
Avanzato (su LibreOffice ver.
4.1 .2.3. - N.d.T.). Spuntate "Abilita le
funzionalità sperimentali" e
premete OK. Riavviate LibreOffice e
aprite la presentazione.

Quando impostate l'applicazione
di controllo Remote avrete bisogno
dell'indirizzo IP del computer su cui
eseguite LibreOffice. Da un
terminale Linux, il seguente
comando dovrebbe funzionare per
la maggior parte degli utenti:

ifconfig eth0

L'informazione necessaria è sulla
riga che inizia con "inet
addr:xxx.xxx.xxx.xxx", dove
xxx.xxx.xxx.xxx è l'indirizzo IP del
proprio computer. Scrivetelo da
qualche parte e conservatelo per
dopo. Vi servirà quando
imposterete l'app Remote.

Ora, installeremo l'app Impress
Remote. Dallo store Google Play,
cercate Impress Remote e
installatela sul vostro cellulare o
tablet. La prima volta che aprite
l'app vedrete una schermata
piuttosto vuota. Selezionate
"Aggiungi manualmente il computer
wi-fi". Inserite un nome per il
computer e l'indirizzo IP.
Selezionate 'Aggiungi'. Selezionate
il computer dalla lista e
connettetevi. Tornate a Impress,
Presentazione > Impress Remote.
Inserite il codice fornito
dall'applicazione e premete
'Connetti'. Nell'applicazione
Remote, premete 'Avvia
presentazione' per avviare la
presentazione.

Se il vostro computer ha il
Bluetooth, potete anche
connettervi accoppiando il cellulare
con il computer. Una volta avviata
l'applicazione, questa eseguirà una
scansione dei dispositivi usando il
Bluetooth e potete selezionare
esattamente il vostro dispositivo
dalla lista. Vi occorre sempre
abilitare Remote e le opzioni
sperimentali in LibreOffice.

Nota : se avete un firewall in
esecuzione sul vostro computer,
dovrete aprire il servizio TCP sulla
porta 1 599 per comunicare tramite
WiFi.

USARE L'APPLICAZIONE

HH OOWW--TTOO
Scritto da Elmer Perry LLiibbrreeOOffffiiccee PPaarrttee 3322:: IImmpprreessss RReemmoottee
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IMPRESS REMOTE

L'applicazione Remote è
piuttosto elementare, ma
diciamocelo, il meno complica il
meglio quando stiamo facendo una
presentazione. La barra degli
strumenti in alto ha l'ora attuale,
comoda quando la presentazione
deve iniziare o terminare a un certo
orario. A sinistra dell'orario si può
cambiare la vista e a destra c'è il
menù.

Quando si avvia una
presentazione, abbiamo la vista per

scorrere le diapositive della
presentazione. Questa vista è la più
utile, perché mentre siamo in
modalità scorrimento, possiamo
anche vedere ogni nota creata per
la diapositiva. Sebbene possiamo

usare il dito per muoverci tra le
diapositive, non è il metodo
migliore salvo che non serva
soltanto per andare avanti e
indietro di diverse diapositive nella
presentazione. Il migliore, o
previsto, modo di spostarsi
attraverso la presentazione è
attraverso i pulsanti volume su e
giù. Con il pulsante su ci si sposta in
avanti e con il pulsante giù ci si
sposta indietro nella presentazione.

Avvolte, occorre mettere in
pausa la presentazione e spostare
l'attenzione della platea dallo
schermo a qualcos'altro. Impress
Remote ci dà la possibilità di
annerire lo schermo. Nel menù
dell'applicazione, selezionate
"Schermo vuoto". La schermata
della presentazione si annerirà. Una

volta pronti a riprendere la
presentazione, basta premere
"Ritorna alla diapositiva". La
presentazione riprenderà da dove
era stata lasciata.

Possiamo visualizzare le
diapositive in due diversi modi. Uno
lo abbiamo già visto, la modalità a
scorrimento. Possiamo commutare
tra le due modalità selezionando il
pulsante che cambia la vista. Nella
modalità scorrimento, ci si sposta
velocemente a una diapositiva
scorrendo con il dito. Per
selezionare una diapositiva nella
vista a elenco, basta selezionarla.
Ciò è pratico solo per le diapositive
fisse. Ogni diapositiva con
animazioni richiederà l'uso dei
pulsanti volume su e giù.

Se si seleziona l'orologio, c'è
l'opzione di lasciarlo alla data
attuale o di avviare un cronometro.
Selezionare il cronometro per
usarlo. Ci saranno le opzioni Avvia e
Ripristina. Premete Avvia per
avviare il timer.I l timer inizierà il

HOWTO - LIBREOFFICE Parte 32



full circle magazine #79 1 0 indice ^

La storia lavorativa, di
programmazione e informatica di
Elmer Perry include un Apple I IE, con
alcuni Amiga, un generoso aiuto di
DOS e Windows e una spolverata di
Unix, il tutto ben mescolato con Linux
e Ubuntu. I l suo blog si trova presso
http://eeperry.wordpress.com
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conteggio e le opzioni cambieranno
in Pausa e Riavvia. Selezionate
Pausa per sospendere il conteggio e
Riavvia per ricominciare da 0.00. È
comodo per sincronizzare
un'attività o per lavorare sulla
tempistica della presentazione.

Nel menù dell'applicazione c'è la
voce Opzioni. La prima opzione è
per usare i pulsanti volume su e giù
per controllare la presentazione.
Non posso pensare a un buon
motivo per disattivarla, ma credo
che sia lì perché qualcuno aveva un
motivo. La seconda opzione serve
ad abilitare la connessione wireless
tra il cellulare e il computer. Questa
permette all'applicazione di cercare
automaticamente sulla rete
wireless il dispositivo che sta
eseguendo LibreOffice Impress con
il servizio Remote attivo. Infine,
l'opzione Commuta computer
permette di passare a un altro
computer.

CONCLUSIONI

Quando si fa una presentazione,
è simpatico disporre di una mobilità.
L'applicazione Android Impress
Remote ci fornisce tale mobilità
permettendoci di controllare la
nostra presentazione Impress dal
nostro cellulare o tablet Android. È
facile da impostare tramite
Bluetooth o WiFi. L'interfaccia non è
ingombrante, rendendola facile da
usare e controllare. Poiché
l'applicazione è stata sviluppata
dalle stesse persone che hanno
sviluppato LibreOffice, le
compatibilità future sono pressoché
assicurate.

PYTHON EDIZIONI SPECIALI:

http://fullcirclemagazine.org/issue-py01 / http://fullcirclemagazine.org/issue-py02/

http://fullcirclemagazine.org/python-
special-edition-issue-three/

http://fullcirclemagazine.org/python-
special-edition-volume-four/

http://fullcirclemagazine.org/python-
special-edition-volume-five/

http://fullcirclemagazine.org/python-
special-edition-volume-six/

http://eeperry.wordpress.com
http://fullcirclemagazine.org/issue-py01/
http://fullcirclemagazine.org/issue-py02/
http://fullcirclemagazine.org/python-special-edition-issue-three/
http://fullcirclemagazine.org/python-special-edition-volume-four/
http://fullcirclemagazine.org/python-special-edition-volume-five/
http://fullcirclemagazine.org/python-special-edition-volume-six/
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U sare HSQLDB, il sistema
predefinito di gestione dei

database (DMS) in LibreOffice Base, è
ottimo per la creazione di nuovi
database, ma a volte serve
connettersi a un database esistente o
ad altri DMS quali MySQL, dBase,
JDBC, Oracle, PostgreSQL e altri. Vi ho
mostrato come connettersi a una
semplice base di dati in un foglio di
calcolo nel numero 52. Oggi, vi
mostrerò come connettersi a un
database creato in MySQL.

MySQL è un DMS usato su molti
siti web. Wordpress e altri sistemi di
gestione dei contenuti usano MySQL
per i loro database. Potreste avere
molti motivi per accedere a un
database creato in MySQL. MySQL è
open source e lo potete installare dal
vostro gestore di software.

INSTALLARE MYSQL

Installare MySQL dal gestore di
software richiede l'installazione di due
pacchetti. Il primo è "mysql-client", il
programma client per MySQL che
permette di interagire con MySQL.

Se si installerà MySQL sulla propria

macchina, servirà installare anche il
pacchetto MySQL server: "mysql-
server". Una volta installato, richiederà
la password di "root" e una conferma.
Questa è la password principale di
MySQL. Annotarla da qualche parte, se
ne avrà bisogno più tardi. Se ci si
connette a un database su una
macchina differente, questo
pacchetto non servirà.

L'ultimo pacchetto necessario da
installare è "libreoffice-mysql-
connector". Permette di connettersi a
MySQL senza usare un involucro
ODBC o JDBC.

CREARE UN DATABASE MYSQL
DI PROVA

Se è la prima volta che ci si
connette a un database esterno
usando LibreOffice Base, raccomando
di creare un database di prova sul

quale poter fare errori e imparare. Si
possono installare dei programmi
quali PHP MyAdmin o EMMA, ma
penso sia più facile usare solo la linea
di comando del client MySQL.

Per connettersi a MySQL sulla
propria macchina locale, usare il
comando:

mysql -h localhost -u root -p

MySQL richiederà la password di
"root". Inseritela e verrete accolti con
un messaggio di benvenuto e il
prompt "mysql>". Per connettersi a un
server MySQL su un altro computer,
sostituite "localhost" con il nome del
server o il suo indirizzo IP. Tenete a
mente che servirà impostare MySQL
per accettare le connessioni remote.
Per i dettagli su come fare, leggete
questo tutorial:
http://www.cyberciti.biz/tips/how-do-
i-enable-remote-access-to-mysql-

database-server.html

Per creare un database usare il
seguente comando nel prompt di
MySQL:

CREATE DATABASE <dbname>:

dove <dbname> è il nome che si
vuole dare al database. Per creare
un database chiamato "myTestDB"
inserire:

CREATE DATABASE myTestDB;

MySQL risponde con un messaggio
sull'avvenuta esecuzione della query.
Inserire

SHOW DATABASES;

per generare un elenco di tutti i
database. Si dovrebbe vedere il
proprio nuovo database fra quelli
elencati. Un database vuoto è tutto
ciò che serve per connettersi a MySQL
da Base, ma è possibile anche
connettersi a un database pienamente
funzionale; ma, come ho detto, è
meglio prima fare pratica su uno di
prova. Digitare "quit" e premere Invio
per uscire dalla sessione MySQL.

http://www.cyberciti.biz/tips/how-do-i-enable-remote-access-to-mysql-database-server.html
http://www.cyberciti.biz/tips/how-do-i-enable-remote-access-to-mysql-database-server.html
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CONNETTERE BASE AL

DATABASE MYSQL

Ora la parte per la quale abbiamo
lavorato, l'effettivo collegamento tra
Base e il database MySQL. Iniziamo
creando un nuovo documento
database in LibreOffice, File > Nuovo
> Database. Useremo questo
documento per connetterci al
database creato precedentemente.
Usando la procedura guidata di Base
(raccomandata), ci sono cinque passi
da seguire.

Passo 1 : vogliamo connetterci a
un database esistente. Non
confondiamo questo con la
connessione a un file di database
esistente. Vogliamo l'ultima
selezione. Selezioniamo MySQL dalla
lista a tendina e facciamo clic su
Avanti.

Passo 2: poiché abbiamo
installato "libreoffice-mysql-

connector", non dobbiamo usare la
connessione ODBC o JDBC.
Selezioniamo "Connettiti in modo
diretto" e premiamo Avanti.

Passo 3: il database è il nome del
database che abbiamo appena creato
in MySQL. Il nostro database di
esempio era "myTestDB". Il server è
"localhost" per il computer locale, o il
nome server o indirizzo IP per l'altro
computer. Lasciare la Porta con il
valore predefinito, salvo che non lo
abbiate cambiato nelle vostre
impostazioni di MySQL o vi sia stato
detto di farlo dal vostro dipartimento
IT. Premere Avanti.

Passo 4: il nome utente che serve
per connettersi a MySQL dal proprio
computer. Usare "root" se ci si
connette a MySQL sul proprio

computer locale. Spuntare "Password
necessaria". Premere "connessione di
prova". Verrà chiesta la password.
Inseritela e premete OK. Se avete
impostato tutto correttamente,
riceverete un messaggio indicante il
successo nella connessione tra Base e
il database. Fare clic su OK nel
messaggio e poi su Avanti.

Passo 5: Selezionare registra o
non registra a seconda delle proprie
necessità per il database. Un
database registrato è disponibile in
altri moduli di LibreOffice. Spuntare
"Apri il database per la modifica".
Fare clic su Fine. Base chiederà un
nome per il file. Inserirlo e premere
Salva.

Ora si può interagire con il
database MySQL nello stesso modo
in cui si farebbe con un database
HSQLDB. Si possono creare tabelle,
query, report e moduli proprio come
si farebbe con il DMS predefinito. Si
deve porre l'attenzione ai tipi di dato
in quanto sono leggermente diversi in
MySQL. Per un rapido sguardo ai tipi
di dato HSQLDB vedere il mio articolo
presso http://wp.me/pvwht-8Q. Per
una lista di tipi di dato MySQL, vedere
http://dev.mysql.com/doc/refman/5.
0/en/data-type-overview.html.

Sebbene sia ottimo usare il DMS
predefinito per i nuovi database, a
volte diventa necessario connettersi
a dei database esistenti. In questo
articolo, è stato mostrato come farlo
connettendosi a un database esterno
MySQL. È stato installato MySQL e
creato un database vuoto. Usando la
procedura guidata di Base, ci siamo
connessi a tale database dove poter
creare tabelle, moduli, query e report
per interagire con il database. Base
può anche connettersi ad altri tipi di
database quali dBase, JDBC, Oracle,
PostgreSQL e altri.

http://wp.me/pvwht-8Q
http://dev.mysql.com/doc/refman/5.0/en/data-type-overview.html
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C on il rilascio di LibreOffice 4 sono
arrivate nuove funzionalità e

migliorie. Tra le più interessanti c'è la
Barra Laterale Sperimentale. La nuova
barra laterale pone in un unico posto
molte azioni e strumenti, eliminando,
permolti oggetti, la necessità della
barra degli strumenti formattata.

Oggi daremo uno sguardo alla barra
laterale e a come si armonizza con il
documento in uso. Bisogna ricordarsi
che la barra laterale è una funzionalità
sperimentale, il che significa possibili
crash del programma senza
avvertimento. Quindi raccomando di
salvare spesso durante il suo uso.

IMPOSTAZIONE

Poiché la barra laterale è
sperimentale, è necessario attivarla. Da
qualsiasi schermata di LibreOffice:
Strumenti > Opzioni > LibreOffice >
Avanzate. Spuntare "Abilita le
funzionalità sperimentali" (LibreOffice
ver. 4.2.3.3. - N.d.T.) e premere OK. Sarà
necessario riavviare LibreOffice al fine
di applicare questo cambiamento.

PANORAMICA

La barra laterale per LibreOffice è
simile a quella di Calligra o al ribbon di
Microsoft Office. Benché non può
sostituire ogni cosa, vi ritroverete a
usarla al posto della barra degli
strumenti formattata e alle finestre di
dialogo. La barra laterale ha
effettivamente più caratteristiche della
barra degli strumenti formattata
predefinita.

Per Impostazione predefinita la

barra laterale è ancorata nella parte
destra della finestra principale. Si può
mostrare o nasconderla usando il
pulsante mostra/nascondi sul bordo
interno o attraverso il menù Visualizza
> Barra laterale. Dal menù della barra
laterale è possibile
ancorarla/disancorarla. Si può anche
personalizzarla rimuovendo i pannelli
che non si useranno.

La barra laterale è una raccolta di
pannelli. La loro disponibilità dipende
dal programma che si sta usando. È
possibile accedere a ciascun pannello
selezionando l'icona nella parte destra
della barra laterale o dal suo menù.
Ciascun pannello serve da scorciatoia
per i diversi strumenti nel programma.
Di questi, personalmente utilizzo molto
spesso 'Proprietà' e 'Stili e
formattazione'. Diamo un'occhiata più
da vicino a ciascuno.

PROPRIETÀ

Il pannello 'Proprietà' mostra le
proprietà dell'oggetto corrente nel
documento. Si possono regolare le
differenti proprietà utilizzando le icone
nel pannello. Cambiare le proprietà
utilizzando queste icone equivale a

cambiarle manualmente attraverso la
barra degli strumenti e le finestre di
dialogo, significando che non ha effetti
sullo stile di base assegnato
all'oggetto, ma solo sull'oggetto
attuale. Se non si trova una proprietà, è
possibile fare clic sul pulsante "Altre
opzioni" nell'angolo di ciascuna
tipologia di proprietà per ottenere una
completa finestra di dialogo con
schede. È possibile ridurre ed
espandere ciascun blocco usando il
relativo pulsante vicino al titolo del
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blocco.

Come esempio, quando si digita in
un documento di Writer si vedono tre
blocchi di proprietà nel pannello
'Proprietà': 'Carattere', 'Paragrafo' e
'Pagina'. Il blocco 'Carattere' permette
di controllare differenti impostazioni
relative al testo: font, grassetto,
corsivo, colore, ecc. Il blocco 'Paragrafo'
permette di controllare l'allineamento
del paragrafo, la spaziatura, i margini,
ecc. Il blocco 'Pagina' fa cambiare la
dimensione della pagina,
l'orientamento, i margini e le colonne.

STILE E FORMATTAZIONE

La barra laterale prende la finestra
'Stile e formattazione' e la ancora a se.

Ciò permette un rapido accesso ai
propri differenti stili. Sebbene sia
sempre possibile usare i pulsanti sulla
barra degli strumenti formattata, la
nuova barra laterale fornisce una
locazione centrale per tale strumento e
per altri simili. La finestra fornisce
persino stili suddivisi per tipologia
(caratteri, paragrafi, cornici, pagine e
liste), oltre alla lista a comparsa di
sotto-categorie. Si possono sempre
creare e modificare stili nello steso
modo della finestra 'Stile e
formattazione'.

GALLERIA

La 'Galleria' è una collezione di
immagini da usare nei propri
documenti. Il pannello 'Galleria'
presenta un elenco di categorie in cima,

chiamate temi, e un elenco di immagini
nella parte inferiore. È possibile usare
questa libreria di immagini per inserire
clip-art e sfondi nei documenti, nonché
suoni nelle presentazioni. Si possono
aggiungere e creare nuovi temi nella
propria galleria. Un completo how-to
sulla libreria 'Galleria' sarà oggetto di
un futuro articolo.

NAVIGATORE

Il 'Navigatore' è un catalogo delle
intestazioni, tabelle, sezioni, immagini,
ecc., dei propri documenti. Permette di
muoversi rapidamente da un punto a
un altro del documento tramite
riferimento a un oggetto. Ciò diventa
abbastanza utile in un documento
grande ed è un buon motivo per
assegnare nomi significativi ai propri

oggetti e immagini OLE.

PAGINEMASTER (SOLO SU

IMPRESS)

Il pannello 'Pagine Master' viene
usato per selezionare e creare pagine
mastro in Impress. Ho parlato delle
pagine mastro nella parte 1 6 di questa
serie, su FCM nr.63:
http://fullcirclemagazine.org/issue-63/.
Questo pannello è solo un
trasferimento della vecchia sezione
Master Page del pannello Tasks di
Impress.

ANIMAZIONE PERSONALIZZATA

(SOLO SU IMPRESS)

Il pannello 'Animazione
personalizzata' è usato per animare
oggetti su una diapositiva di Impress.
Ho parlato delle animazioni nella parte
1 8 di questa serie, su FCM nr.65:
http://fullcirclemagazine.org/issue-65/.
Anche questo è un trasferimento del
vecchio pannello Tasks di Impress nel
nuovo formato.

CAMBIO DIAPOSITIVA (SOLO SU

IMPRESS)

'Cambio diapositiva' controlla come

http://fullcirclemagazine.org/issue-63/
http://fullcirclemagazine.org/issue-65/
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si muove una presentazione da una
diapositiva all'altra. Permaggiori
dettagli vedere la parte 1 8 di questa
serie, su FCM nr.65:
http://fullcirclemagazine.org/issue-65/.
Il pannello è un'altra copia del vecchio
pannello Tasks di Impress.

FUNZIONI (SOLO SU CALC)

Il pannello 'Funzioni' fornisce
l'accesso a tutte le funzione di Calc. Un
menù a comparsa divide le funzioni in
categorie, comprese le categorie
"Usate più di recente" e "Tutte". Al di
sotto c'è l'elenco di tutte le funzioni
della categoria selezionata. Si possono
inserire funzioni nella cella in uso
facendo doppio clic sul nome della

funzione o selezionando il pulsante 'fx'
vicino al menù a comparsa delle
categorie. Ciò fornisce un rapido
accesso alle funzioni ed è molto più
facile (è mia opinione) della procedura
guidata.

La barra laterale sperimentale è
uno strumento che fornisce l'accesso
agli strumenti più usati, in maniera più
veloce e facile.LibreOffice lo ha
realizzato facendo espansioni del
pannello e combinazioni delle barre
degli strumenti più comuni,
trasferendo vecchi pannelli e
procedure guidate nel nuovo formato.
È paragonabile alla barra laterale di
Calligra o alla barra ribbon di Microsoft
Office. L'ho trovata comoda da usare,
ma si tenga a mente che è
sperimentale e potrebbe causare
occasionali crash a Libreoffice.

EDIZIONI SPECIALI DI PYTHON:

http://fullcirclemagazine.org/issue-py01 / http://fullcirclemagazine.org/issue-py02/

http://fullcirclemagazine.org/python-
special-edition-issue-three/

http://fullcirclemagazine.org/python-
special-edition-volume-four/

http://fullcirclemagazine.org/python-
special-edition-volume-five/

http://fullcirclemagazine.org/python-
special-edition-volume-six/

http://fullcirclemagazine.org/issue-65/
http://eeperry.wordpress.com
http://fullcirclemagazine.org/issue-py01/
http://fullcirclemagazine.org/issue-py02/
http://fullcirclemagazine.org/python-special-edition-issue-three/
http://fullcirclemagazine.org/python-special-edition-volume-four/
http://fullcirclemagazine.org/python-special-edition-volume-five/
http://fullcirclemagazine.org/python-special-edition-volume-six/


full circle magazine nr.82 1 4 indice^

HHOOWW--TTOO
Scritto da Elmer Perry LLiibbrreeOOffffiiccee PPaarrttee 3355 :: LLaa GGaalllleerriiaa

C ollezionare clipart per utilizzarle
nelle proprie newsletter, fogli

elettronici, presentazioni o altri
documenti, può diventare un attività
tempestiva. Specialmente quando
devono essere organizzate e ricercate.
LibreOffice possiede una sua galleria
integrata per collezionare e organizzare
immagini, suoni e video. La galleria
organizza i file in categorie chiamate
temi. Si possono aggiungere i file dalla
Galleria direttamente sul documento. La
creazione di nuovi temi consente di
aggiungere file personali alla collezione.

LA GALLERIA

È possibile accedere alla Galleria in
tre differenti modi: attraverso il menù
(Strumenti > Galleria); tramite un
pulsante presente sulla barra degli
strumenti; attraverso un pannello

presente nella barra laterale
sperimentale. Per impostazione
predefinita, la Galleria è agganciata sotto
la barra di formattazione. È possibile
sganciare e agganciare la Galleria con la
combinazione dei tasti Ctrl + doppio-clic
sul bordo della maschera. Si può
utilizzare il pulsante 'Nascondi/Mostra'
sulla parte inferiore della maschera per
visualizzare o nascondere la Galleria
mentre è agganciata. Se ci si posiziona
sopra il bordo inferiore della maschera, il
puntatore delmouse si trasformerà in
una doppia freccia e sarà possibile
regolare l'altezza della maschera
agganciata.

Sulla parte sinistra della Galleria c'è la
lista dei temi. Selezionandone uno,
cambiano i file mostrati nel pannello
principale. Quest'ultimomostra i file
disponibili per il tema selezionato. Sopra

l'area principale ci sono due pulsanti per
mostrare i file in vista icone o dettagli.
Accanto a questi pulsanti, vengono
mostrati il nome del tema, il nome del
file e il suo percorso.

UTILIZZARE LA GALLERIA

La Galleria consente di inserire un file
come copia, collegamento o sfondo.
Quando si inserisce come copia, il file
viene incorporato all'interno del
documento stesso e non fa riferimento a
nessun altro file. Se lo si inserisce come
collegamento, nel documento viene
creato un riferimento al file in questione.
Se si apre un documento con file
collegati, questi verrebbero mostrati
solo se si trovassero nella posizione a cui
il link fa riferimento. Se il file deve
viaggiare attraverso più computer, allora
è meglio inserirne una copia. Se il
documento risiederà su un solo
computer allora si potrebbe inserire
tranquillamente un collegamento.

Per inserire una copia di un file della
Galleria in un documento, selezionare il
tema che lo contiene e poi il file
interessato. È possibile anche trascinare
e poi rilasciare il file dalla Galleria
direttamente nel documento, oppure

fare clic con il tasto destro delmouse e
selezionare il menù Inserisci > Copia.

Per collegare nel documento un file
dalla galleria, selezionare il tema e il file e
tenere premuti i tasti SHIFT + CTRL
mentre lo si trascina e rilascia all'interno
del documento, oppure fate clic con il
tasto destro delmouse e poi Inserisci >
Collegamento ipertestuale.

Qualche volta si vorrà utilizzare
un'immagine come sfondo per un
paragrafo o per una pagina. Per
impostarla come sfondo di una pagina,
selezionare il tema e l'immagine, poi fare
clic con il tasto destro delmouse
sull'immagine e quindi Inserisci > Sfondo
> Pagina. Per impostare un'immagine
come sfondo del paragrafo, clic con il
tasto destro e poi Inserisci > Sfondo >
Paragrafo.

GESTIRE LA GALLERIA

Una interessante caratteristica della
Galleria è la possibilità di inserire propri
file all'interno della collezione. Non è
possibile, comunque, aggiungere,
rimuovere o cancellare i temi predefiniti.
Per aggiungere dei propri file all'interno
della Galleria, si dovrà creare il proprio
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tema. Per crearlo, premere il pulsante
'Nuovo Tema', che aprirà la relativa
finestra di dialogo. Nella scheda
'Generale', inserire il nome che si vuole
dare al tema. Ora sarà possibile
aggiungere i file al tema andando sulla
scheda 'File' oppure premendo
semplicemente 'OK' per salvare il tema.

Aggiungere file al tema appena
creato è facile. Si possono aggiungere i
file uno alla volta trascinandoli nel
pannello principale della finestra, con il
proprio tema selezionato. Per
aggiungere file in maniera selettiva o per
aggiungere un'intera cartella, fare clic
con il tasto destro delmouse sul titolo
del tema e selezionare la voce
'Proprietà'. Verrà mostrata la finestra di
dialogo 'Proprietà'. È la stessa finestra di
dialogo che appare quando si crea un
nuovo tema, quindi è possibile utilizzare
questo metodo per aggiungere i file
mentre si sta creando un nuovo tema.
Selezionare la scheda 'File', quindi

premere su 'Trova File'. Utilizzare la
finestra di dialogo per navigare nella
cartella dove si trovano i file che si
vogliono aggiungere, quindi fare clic su
'Seleziona'. Apparirà un elenco dei file
nella casella di riepilogo. Se necessario,
utilizzare il menù a tendina poco più
sopra per filtrare i risultati. Prendersi un
po’ di tempo per scorrere la lista dei filtri
disponibili, per avere un idea di quanti
formati immagine accetta la Galleria. Per
file di tipo immagine, è possibile
ottenere un anteprima spuntando la
casella di controllo 'Anteprima'. Una
volta trovato il file desiderato,
selezionarlo e fare clic su 'Aggiungi' per
aggiungerlo al tema, oppure premere
'Aggiungi Tutti' per aggiungere tutti i file
presenti nella casella di riepilogo.

Si potrebbe voler aggiungere i file
con l'intenzione di non tenerli sempre
memorizzati. Si potrebbe decidere di
aggiungerli solo per un dato progetto.
Una volta terminato e non si ha più

bisogno dei file, si vorranno cancellare i
file e il tema creato per il progetto. Per
cancellare i file da un tema, fare clic con il
tasto destro delmouse e selezionare
'Elimina'. Si può anche cancellare l'intero
tema con tutti i suoi file facendo clic,
sempre con il tasto destro delmouse, sul
tema e selezionando 'Elimina'. Bisogna
ricordare che non esiste nessuna
possibilità di annullare tale operazione
una volta eseguita e che eliminare un file
dalla Galleria non significa eliminarlo dal
computer, ma solo dalla lista dei temi
della Galleria.

LibreOffice fornisce una libreria
multimediale chiamata Galleria. La
Galleria è divisa in collezioni chiamate

temi. Si possono aggiungere temi e file
personalizzati alla Galleria. Se un file o un
tema sono stati creati solo per un
determinato progetto, si può eliminarli a
progetto ultimato. La Galleria è
disponibile in tutti i moduli della suite e
aiuta a gestire la consistenza di
newsletter, fogli di calcolo,
presentazioni, database e report.

La storia lavorativa, di programmazione
e informatica di Elmer Perry include un
Apple IIE, con alcuni Amiga, un
generoso aiuto di DOS e Windows e
una spolverata di Unix, il tutto ben
mescolato con Linux e Ubuntu. Il suo
blog si trova presso:
http://eeperry.wordpress.com

http://eeperry.wordpress.com
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S e si lavora abbastanza a lungo con i
database, si arriverà in una

situazione in cui sarà necessario avere
una tabella strutturata in maniera
leggermente diversa, oppure si avrà
bisogno di una query sotto forma di
tabella che sarà poi possibile utilizzare.
La risposta a questi problemi sono le
“Viste”. Una vista è una query che
funziona come una tabella che si può
utilizzare in altre query, moduli o
controlli. Oggi vi mostrerò di come
questo sia utile quando si creano dei
moduli.

LE NOSTRE TABELLE
Andremo a costruire un semplice

database composto di due tabelle. Il
database terrà traccia dei progetti di una
società e ci consentirà di assegnare un
membro di una squadra a ciascun
progetto. Di seguito la struttura delle
tabelle che creeremo.

Project Table
Field|Type|Properties
ID|Integer|Primary Key, Auto
Increment

Title|varchar(50)|Not Null
Description|varchar(250)
Due|Date
MemberID|Integer|foreign key

TeamMember Table

Field|Type|Properties
ID|Integer|Primary Key, Auto
Increment
FirstName|Varchar(25)|Not
Null
LastName|Varchar(25)|Not Null

Quello mostrato a destra è il codice
SQLper creare le due tabelle . Creare un
nuovo documento database, quindi
andare su Strumenti > SQL e digitare i
comandi a mano o con un copia-incolla.

E’ possibile recuperare i comandi SQL
su pastebin.com al seguente indirizzo:
http://pastebin.com/Wyb3R5Fz.

La chiave per il nostro obiettivo è la
chiave estranea “MemberID” nella
tabella “Project” che collega al campo
“ID” della tabella “TeamMember”.
Quando creeremo il nostro modulo
creeremo un elenco a tendina per
selezionare il membro che è
responsabile del progetto. E’ da notare
che la tabella “TeamMember” offre i
campi del Nome e Cognome. Il controllo
della lista ci consente di usare solo un
campo nella lista. Potremmo visualizzare
solo il cognome nell’elenco a tendina, ma
cosa accadrebbe se due membri
avessero lo stesso cognome?
Risolveremo questo problema creando
una vista che unirà il nome e il cognome

in un unico campo dal nome “Name”.
Utilizzeremo la nostra vista per popolare
la finestra della lista a tendina.

Se le tabelle non appaiono
nell’elenco delle tabelle dopo aver
eseguito i comandi, Revisiona > Aggiorna
Tabella popoleranno l’elenco.

CREARE LAQUERY/VISTA
Per creare la nostra vista,

utilizzeremo un processo a due passi.
Prima creeremo una query, poi
convertiremo la query stessa in una vista.
Nella nostra query uniremo i campi
nome e cognome per creare un unico

campo. Otterremo anche il campo “ID”
dato che ci servirà per ricollegarci alla
tabella “Project”.

Per creare la query selezioniamo
l’opzione “Query” nel pannello
“Database”. Nel pannello “Azioni”,
selezionare “Crea Nuova Query in Vista
SQL”. Il seguente comando SQL
genererà la nostra query:

SELECT "FirstName" | | ' ' | |
"LastName" AS "Name",
"ID" FROM "TeamMember";

Se avete familiarità con SQL, questa
sembra una query standard ad eccezione

drop table "Project" if exists;
drop table "TeamMember" if exists;

create table "TeamMember" (
"ID" integer generated by default as identity

(start with 1) not null primary key,
"FirstName" varchar(25) not null,
"LastName" varchar(25) not null

);

create table "Project" (
"ID" integer generated by default as identity

(start with 1) not null primary key,
"Title" varchar(50) not null,
"Description" varchar(250),
"Due" date,
"Member" integer,
constraint FK_MEM foreign key ("Member")

references "TeamMember" ("ID")
);

http://pastebin.com/Wyb3R5Fz
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dei doppi simboli di pipe “||”. Questi sono
usati per concatenare assieme delle
stringhe. Nel comando, selezioniamo
ciascun “FirstName” e lo uniamo ad uno
spazio, poi prendiamo il risultato e lo
uniamo a “LastName”. Finalmente
nominiamo questa stringa con “Name”.
Abbiamo anche l’“ID” dato che definisce
ciascun record. E’ possibile provare la
query per essere certi che funzioni, a
questo punto, però, i risultati saranno
vuoti ma la query verrà eseguita senza
errori. Salvare la query come
“QueryTeam”.

Trasformare la query in vista è molto
semplice, basterà fare clic con il tasto
destro delmouse sul nome della query e
selezionare “Crea come Vista”.
Rinominare la vista come “TeamView”.
Se si seleziona “Tabelle” nel pannello
“Database”, si vedrà “TeamView”
elencata nelle tabelle.

CREARE I MODULI
Creeremo un modulo per il membro

della squadra ed un modulo di progetto
per l’inserimento dei dati.

Il modulo per il membro della
squadra è il più facile, quindi inizieremo
con questo.

Nella prima schermata cliccate
sull’icona “Moduli” nel pannello

“Database” e selezionare “Utilizzare
procedura guidata per la creazione del
modulo.” Il modulo della creazione
guidata apparirà.

Sulla prima schermata selezionare
“Table: TeamMember” dalla casella a
menù a tendina. Spostare i campi
“FirstName” e “LastName” nella casella
di riepilogo chiamata “Fields in the
form.” Cliccare sul tasto “Successivo >” .
Non ci sono dei sotto-moduli quindi si
può premere ancora “Successivo >”. Al
passo 5 usare qualsiasi delle opzioni
disponibili per organizzare i controlli ad
eccezione di quelli della tabella. Al passo
6 accettare semplicemente le opzioni di
default. Al passo 7 scegliere lo stile che si
preferisce. Quando si arriva al passo 8,
nominare il modulo
“TeamMemberForm” e lasciarlo su
“Lavora con il modulo”. Quando si clicca il
tasto “Fine” il modulo si aprirà per
l’inserimento dei dati. Aggiungere
qualche nome per testare il modulo del
progetto.

Per il modulo del progetto abbiamo
bisogno delle stesse cose, eccezion fatta
per l’uso della “Table: Project” dal menù
a tendina allo step 1 e della selezione di
tutti i campi ad eccezione di “ID” per
l’inclusione nelmodulo. Rinominare il
modulo “ProjectForm” e selezionare
“Modifica Modulo” al passo 8. Questa
volta, il modulo invece che aprirsi per

l’inserimento dei dati si apre per la
revisione.

Quando si creano moduli utilizzando
la procedura guidata, il processo
raggruppa la maggior parte dei dati in
caselle di testo con un etichetta per ogni
campo. Al fine di cambiare i controlli per
il campo dati, si deve dividere la casella di
testo dall’etichetta. Nel nostro caso si
vuole il campo “Member”, quindi fare clic
destro sull’etichetta “Member” della
casella di testa e selezionare Group >
Ungroup. Cliccare sullo sfondo del
modulo per deselezionare entrambi.
Fare clic con il tasto destro sulla casella di
testo e selezionare “Elimina”. Dalla barra
degli strumenti dei moduli selezionare la
casella di riepilogo. Se la barra degli
strumenti dei moduli non è visualizzata,
allora andare almenù Vista > Barra degli
Strumenti > Controlli Moduli per
mostrarla. Una volta selezionata la
casella di riepilogo, il cursore diventerà
un mirino “+”. Cliccare e trascinare per
creare il menù a discesa. Quando si
rilascerà il bottone delmouse, apparirà la
casella di riepilogo della procedura
guidata.

Selezionare “TeamView” come
tabella e cliccare su “Successivo >”. Il
campo con il quale si vuole riempire la
casella di riepilogo è “Name”, quindi
selezioniamo “Name” e clicchiamo su
“Successivo >”. In fine, abbiamo bisogno

di abbinare i campi con le due tabelle.
Per la “Value Table” selezionare
“Member”. “ID” è il campo da selezionare
per la “List Table” dato che è la chiave
primaria che si accoppia con il campo
della chiave esterna “Member”
all’interno della tabella “Project”.
Salviamo le modifiche e chiudiamo la
finestra di disegno.

Adesso se si inseriscono i nomi in
“TeamMemberForm”, aprendo il modulo
“ProjectForm” i nomi inseriti appariranno
nelmenù a tendina della casella di
riepilogo creata. Al fine di testare la
funzionalità dei moduli, si potrà voler
creare diversi progetti ed assegnare dei
membri a ciascuno di essi.

In questo articolo abbiamo discusso
della vista di una Base di LibreOffice per
creare una nuova tabella partendo da
una già esistente. Abbiamo utilizzato
questa vista per la costruzione di un
modulo che automatizzi il recupero dei
record da quella vista.

La storia lavorativa, di
programmazione e informatica di
Elmer Perry include un Apple I IE, con
alcuni Amiga, un generoso aiuto di
DOS e Windows e una spolverata di
Unix, il tutto ben mescolato con Linux
e Ubuntu. I l suo blog è
http://eeperry.wordpress.com

http://eeperry.wordpress.com

